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WARNING

Thank you for purchasing automation equipment from Automationdirect.com. We want your new DirectLOGIC
automation equipment to operate safely. Anyone who installs or uses this equipment should read this publication (and
any other relevant publications) before installing or operating the equipment.

To minimize the risk of potential safety problems, you should follow all applicable local and national codes that regulate
the installation and operation of your equipment. These codes vary from area to area and usually change with time. It is
your responsibility to determine which codes should be followed, and to verify that the equipment, installation, and
operation are in compliance with the latest revision of these codes.

At a minimum, you should follow all applicable sections of the National Fire Code, National Electrical Code, and the
codes of the National Electrical Manufacturer’s Association (NEMA). There may be local regulatory or government
offices that can also help determine which codes and standards are necessary for safe installation and operation.

Equipment damage or serious injury to personnel can result from the failure to follow all applicable codes and
standards. We do not guarantee the products described in this publication are suitable for your particular application,
nor do we assume any responsibility for your product design, installation, or operation.

Our products are not fault–tolerant and are not designed, manufactured or intended for use or resale as on–line control
equipment in hazardous environments requiring fail–safe performance, such as in the operation of nuclear facilities,
aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in
which the failure of the product could lead directly to death, personal injury, or severe physical or environmental
damage (”High Risk Activities”). Automationdirect.com specifically disclaims any expressed or implied warranty of
fitness for High Risk Activities.

For additional warranty and safety information, see the Terms and Conditions section of our Desk Reference. If you
have any questions concerning the installation or operation of this equipment, or if you need additional information,
please call us at 770–844–4200.

This publication is based on information that was available at the time it was printed.  At Automationdirect.com we
constantly strive to improve our products and services, so we reserve the right to make changes to the products and/or
publications at any time without notice and without any obligation. This publication may also discuss features that may
not be available in certain revisions of the product.

Trademarks
This publication may contain references to products produced and/or offered by other companies. The product and
company names may be trademarked and are the sole property of their respective owners. Automationdirect.com
disclaims any proprietary interest in the marks and names of others.

Copyright 2001, Automationdirect.com Incorporated
All Rights Reserved

No part of this manual shall be copied, reproduced, or transmitted in any way without the prior, written consent of
Automationdirect.com Incorporated. Automationdirect.com retains the exclusive rights to all information
included in this document.



AVERTISSEMENT

Nous vous remercions d’avoir acheté l’équipement d’automatisation de Automationdirect.com�.  Nous tenons à ce que
votre nouvel équipement d’automatisation DirectLOGIC fonctionne en toute sécurité. Toute personne qui installe ou
utilise cet équipement doit lire la présente publication (et toutes les autres publications pertinentes) avant de l’installer ou de
l’utiliser.

Afin de réduire au minimum le risque d’éventuels problèmes de sécurité, vous devez respecter tous les codes locaux et
nationaux applicables régissant l’installation et le fonctionnement de votre équipement. Ces codes diffèrent d’une région à
l’autre et, habituellement, évoluent au fil du temps. Il vous incombe de déterminer les codes à respecter et de vous assurer
que l’équipement, l’installation et le fonctionnement sont conformes aux exigences de la version la plus récente de ces
codes.

Vous devez, à tout le moins, respecter toutes les sections applicables du Code national de prévention des incendies, du
Code national de l’électricité et des codes de la National Electrical Manufacturer’s Association (NEMA). Des organismes de
réglementation ou des services gouvernementaux locaux peuvent également vous aider à déterminer les codes ainsi que
les normes à respecter pour assurer une installation et un fonctionnement sûrs.

L’omission de respecter la totalité des codes et des normes applicables peut entraîner des dommages à l’équipement ou
causer de graves blessures au personnel. Nous ne garantissons pas que les produits décrits dans cette publication
conviennent à votre application particulière et nous n’assumons aucune responsabilité à l’égard de la conception, de
l’installation ou du fonctionnement de votre produit.

Nos produits ne sont pas insensibles aux défaillances et ne sont ni conçus ni fabriqués pour l’utilisation ou la revente en tant
qu’équipement de commande en ligne dans des environnements dangereux nécessitant une sécurité absolue, par
exemple, l’exploitation d’installations nucléaires, les systèmes de navigation aérienne ou de communication, le contrôle de
la circulation aérienne, les équipements de survie ou les systèmes d’armes, pour lesquels la défaillance du produit peut
provoquer la mort, des blessures corporelles ou de graves dommages matériels ou environnementaux (”activités à risque
élevé”). La société  Automationdirect.com� nie toute garantie expresse ou implicite d’aptitude à l’emploi en ce qui a trait
aux activités à risque élevé.

Pour des renseignements additionnels touchant la garantie et la sécurité, veuillez consulter la section Modalités et
conditions de notre documentation. Si vous avez des questions au sujet de l’installation ou du fonctionnement de cet
équipement, ou encore si vous avez besoin de renseignements supplémentaires, n’hésitez pas à nous téléphoner au
770–844–4200.

Cette publication s’appuie sur l’information qui était disponible au moment de l’impression. À la société
Automationdirect.com�, nous nous efforçons constamment d’améliorer nos produits et services. C’est pourquoi nous
nous réservons le droit d’apporter des modifications aux produits ou aux publications en tout temps, sans préavis ni quelque
obligation que ce soit. La présente publication peut aussi porter sur des caractéristiques susceptibles de ne pas être offertes
dans certaines versions révisées du produit.

Marques de commerce
La présente publication peut contenir des références à des produits fabriqués ou offerts par d’autres entreprises. Les
désignations des produits et des entreprises peuvent être des marques de commerce et appartiennent exclusivement à
leurs propriétaires respectifs. Automationdirect.com� nie tout intérêt dans les autres marques et désignations.

Copyright 2001, Automationdirect.com�  Incorporated
Tous droits réservés

Nulle partie de ce manuel ne doit être copiée, reproduite ou transmise de quelque façon que ce soit sans le consentement
préalable écrit de la société Automationdirect.com� Incorporated. Automationdirect.com� conserve les droits
exclusifs à l’égard de tous les renseignements contenus dans le présent document.
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Introduction

Manual Overview

This manual describes the installation and
operation of the Ethernet Base Controller.
You will find the necessary information for
configuring the H2–EBC(–F) and
H4–EBC(–F), installing the module in a
DL205 or DL405 I/O base and connecting
the EBC to a 10BaseT or 10BaseFL
Ethernet network.

You may find other technical manuals useful for your application. For technical
information related to your PC–based control software or your PC, please refer to
the appropriate manual for that product. For more information about the
DirectLOGIC� products, you may want to read the following:

• DL205 User Manual
• DL405 User Manual

You will find this manual helpful for setup and installation if you have chosen to use all
of the following:

• PC-based Control (rather than a traditional PLC CPU)
• Our DL205 or DL405 I/O
• One of our Ethernet Base Controllers for communication to the I/O rack

A familiarity with Ethernet communications and with the setup and installation of
PLCs is helpful. An understanding of electrical codes and industrial control is
essential.

We strive to make our manuals the best in the industry. We rely on your feedback to
let us know if we are reaching our goal. If you cannot find the solution to your
particular application, or, if for any reason you need additional technical assistance,
please call us at

770–844–4200

Our technical support team is happy to work with you in answering your questions.
They are available weekdays from 9:00 a.m. to 6:00 p.m. Eastern Time. We also
encourage you to visit our website where you can find technical and nontechnical
information about our products and our company.

www.automationdirect.com

If you have a comment or question about any of our products, services, or manuals,
please fill out and return the ‘Suggestions’ card that was shipped with this manual.

Overview of this
Manual

Other Reference
Materials

Who Should Read
This Manual

Technical Support
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Conventions Used

The “light bulb” icon in the left-hand margin indicates a tip or shortcut.

The “note pad” icon in the left–hand margin indicates a special note.

The “exclamation mark” icon in the left-hand margin indicates a warning or caution.
These are very important because the information may help you prevent serious
personal injury or equipment damage.

The beginning of each chapter will list the
key topics that can be found in that chapter.

1
Key Topics for 
Each Chapter



In
tr

od
uc

tio
n

In
st

al
la

tio
n 

an
d

S
af

et
y 

G
ui

de
lin

es
1–4

Introduction

Ethernet Base Controller Overview

The Ethernet Base Controller (EBC) provides a low-cost, high-performance
Ethernet link between a PC-based Control system, DL205 and DL405 I/O bases.
The EBC occupies the CPU position of the PLC base and communicates across the
backplane to input and output modules.
Although, the Ethernet Base Controller occupies the CPU slot in the PLC base, the
control function is not performed by the EBC. The control function is performed by
PC–based Control software (which is purchased separately) running on a PC. The
function of the EBC is to:

• process analog and digital input signals
• format the I/O signals to conform to the Ethernet standard
• transmit the signals to the PC-based controller
• receive and translate output signals from the PC-based Control software
• distribute the output signals to the appropriate output module in the

base

The EBC module continually scans all I/O and stores the most recent values in
cache memory. The cache memory contents are available to the PC-based Control
software as a block of data or by individual slot location. The EBC reads all channels
of digital modules on each scan. It reads one channel of each analog module on
each scan, updating that value in cache memory. On the next scan, the EBC
sequences to the next channel and updates that value in cache memory, and so on.
Typically, PC-based Control will request all input and output values at the same time
from the EBC. The EBC passes the cache memory values for all channels of all input
and output modules. By using this method, very fast response times can be
achieved by the PC-based Control system.

PC-based
Control
System

Control Room

H2–EBC

Ethernet

Machine Control

Process Control

H4–EBC

Hub Serial

I/O Values Stored
in Cache Memory
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The H2–EBC and H4–EBC modules support industry standard 10BaseT Ethernet
communications, and the H2–EBC–F and H4–EBC–F modules support 10BaseFL (fiber
optic) Ethernet standards. All EBCs offer 10Mbps transfer rates between your PC
application and your I/O base.

WARNING: For deterministic Ethernet communication you must use a dedicated
network of EBC modules connected to your PC-based control system. The EBC
modules and the PC running PC-based Control Software must be the only devices
on the network.

The H2–EBC(–F) installs in the CPU slot of a DL205 base and communicates across
the backplane to digital and analog input and output modules. The H2–EBC(–F)
does not support remote I/O or Specialty Modules.

RJ45 Port
for 10Base-T

ST bayonet
for 10Base-FL

RJ12
Serial
Port

H2–EBC H2–EBC–F

The H4–EBC(–F) installs in the CPU slot of a DL405 base and communicates across
the backplane to digital and analog, input and output modules. The H4–EBC(–F)
supports up to three expansion I/O bases (see page 2–19), and it supports the
D4–HSC High Speed Counter Module. The H4–EBC(–F) also serves as the power
supply for the local base. Expansion bases have their own power supplies.

RJ45 Port
for 10Base-T

ST bayonet
for 10Base-FL

RJ12
Serial
Port

H4–EBC H4–EBC–F

RJ12
Serial
Port

An RS232C serial port on-board the EBC module allows serial communication to an
operator interface device or other serial device. See your PC-based Control
software documentation to determine whether this EBC feature is supported.

Industry Standard
Ethernet

H2–EBC and
H2–EBC–F

H4–EBC and
H4–EBC–F

RS232C 
Serial Port
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Frequently Asked Questions
Q. What is Ethernet?

A. Ethernet is a specification which defines cable type and signalling methods to be
used in a local-area-network (LAN). An Ethernet network transmits packets of
information between computers at speeds of 10 to 100 million bits per second
(Mbps). Currently the most widely used version of Ethernet technology is the 10Mbps
twisted-pair variety. Ethernet allows multi-vendor products to communicate using
common software protocols.

Q. Which protocols are supported by the EBC?
A. The H2–EBC(–F) and the H4–EBC(–F) support IPX (originated by Novell) and
UDP/IP (Universal Datagram Protocol/Internet Protocol). The Windows NT�
operating system supports both protocols. The UDP/IP protocol is supported within
the TCP/IP suite.

Q. What Ethernet standards should I be familiar with?
A. Below is a short list of most commonly used Ethernet cabling standards and their
key characteristics.

• 10Base-2 –  Thin coaxial cable, which supports a maximum of 30
stations per network and is limited to 185 meters (607ft.) per cable
segment.

• 10Base-5 – Thick coaxial cable, which supports a maximum of 100
stations and is limited to 500 meters (1,640ft.) per segment.

• 10Base-F – Plastic or Glass Fiber Optic maximum of 1024 stations and
distances depend on signaling technology and medium used but can
commonly support up to 2 Kilometers.

• 10Base-T – Unshielded Twisted Pair, which supports a maximum of
1024 stations with a segments of 100 meters, but distance is truly based
on signal loss in decibels (less than 11.5dB loss source to destination).

Q. Which Ethernet specifications are required to install an EBC system?
A. None. Detailed Ethernet specifications are not necessary for implementing the
EBC system.

Q. How do I connect to an Ethernet network?
A. Different types of Ethernet media may be connected to a single LAN network
solution using repeaters, bridges, and adaptor type products. A number of vendors
offer adaptors or transceivers, which provide interconnection of different types of
Ethernet cabling.
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— Setting the Module ID
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— The H4–EBC DIP Switch
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Installation and Setup

Setting the Module ID
Each Ethernet Base Controller must have a Module ID in order to be recognized on
the network, and each Module ID must be unique. Duplicate Module IDs on the same
network will cause unpredictable results and must be avoided.

There are three methods for setting the Module ID, and they are the same for the
H2–EBC and the H4–EBC modules. You can set the Module ID using:

• The DIP switch on the EBC module
• The NetEdit software utility
• The software utility in your PC-based Control software (if a utility is

provided)

We recommend using the DIP switch to set the Module ID because the DIP switch is
simple to set, and the Module ID can be determined by looking at the physical
module, without reference to a software utility.
You can use the DIP switch to set the Module ID to a number from 1 – 63. Do not use
Module ID 0 for communications. The only pupose of Module ID 0 is to allow
communications with a PC while changing the Module ID.
If the DIP switch is set to a number greater than 0, the software tools are disabled
from setting the Module ID. Again, the software tools will only allow changes to the
Module ID if the DIP switch setting is 0 (all switches OFF).
The DIP switch settings are read only at powerup. You must cycle power if you
change the DIP switches.
Software changes to the Module ID do not require cycling power. To set the Module
ID using one of the available software tools, do the following:

• Check to be sure all DIP switches are set to the off position, 
Module ID = 0 (see page 2–3 or 2–4)

• Insert the module in the base (see page 2–5)
• Connect the power wiring (see page 2–6)
• Connect module to the Ethernet network (see page 2–8 through 2–10)
• Apply power
• Link to the module and change the Module ID using the software of your

choice. Remember to update the module before exiting the software.
See note below.

NOTE: Set the Module ID using the method recommended for your PC-based
Control software. The use of NetEdit to set the Module ID is described in Chapter 3.
Some PC-based Control software packages may make automatic updates to the
EBC module configuration, overwriting the configuration developed in NetEdit.

Three Methods for
Setting Module ID

Setting Module ID
with DIP Switches

Setting Module ID
with Software Tool
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The H2–EBC DIP Switch
The EBC DIP switch contains eight individual switches, but only six of these are
active. You will find that the printed circuit board is labeled 0 – 7. The numbers on the
printed circuit board indicate the power of 2 represented by each individual switch.
For example, switch 0 represents 20 (or 1), switch 1 is 21 (or 2), switch 2 is 22 (or 4),
and so on. The figure below shows the binary value of each switch in parentheses ( ).

ON

01234567

Not Used
(32)(16) (8) (4) (2) (1)

The numbers (0–7) printed on the
circuit board indicate the power of 2
represented by each slide switch.

H2–EBC (–F)

202122232425
.... . .

.... . .
Binary Value

The Module ID equals the sum of the binary values of the slide switches set in the ON
position. For example, if you set slide switches 1, 2, and 3 to the ON position, the
Module ID will be 14. This is found by adding 8+4+2=14. The maximum value you can
set on the DIP switch is 32+16+8+4+2+1=63. This is achieved by setting switches 0
through 5 to the ON position.

The H2–EBC (–F)
DIP Switch
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The H4–EBC DIP Switch
The H4–EBC DIP switch contains eight individual switches, but only six of these are
active. Two are not used. Notice that the individual switches are labeled 0 – 7 on the
printed circuit board. The numbers on the printed circuit board indicate the power of
2 represented by each individual switch. For example, switch 0 represents 20 (or 1),
switch 1 is 21 (or 2), switch 2 is 22 (or 4), and so on. The figure below shows the binary
value of each switch in parentheses ( ).

The numbers (0–7) printed on the
circuit board indicate the power of
2 represented by each switch.

202122232425
.... . .

.... . .

Not Used

0
1

2
3

4
5

6
7

(32)(16) (8) (4) (2) (1)

H4–EBC (–F)

Binary Value

ON OFF

The Module ID equals the sum of the binary values of the individual switches set in the
ON position. For example, if you set switches 1 and 3 to the ON position, the Module
ID will be 10. This is found by adding 8+2=10. The maximum value you can set on the
DIP switch is 32+16+8+4+2+1=63. This is achieved by setting switches 0 through 5 to
the ON position. The DIP switch must be set to a number greater than zero.

The H4–EBC (–F)
DIP Switch
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Inserting the H2–EBC or H2–EBC–F into the Base

The H2–EBC plugs into the CPU slot of any DL205 base.
• Locate the grooves on the inside top and bottom of the DL205 base.
• Align the module with the grooves and slide the module into the slot until

the face of the module is flush with the power supply.
• Push in the retaining clips to secure the module.

Align the H2–EBC module with the
grooves in the base and slide it in.

Push the retaining clips
in to secure the module in
the DL205 base.

Intalling the H4–EBC or H4–EBC–F onto the Base

The H4–EBC installed in the CPU position of any DL405 I/O base.

• The EBC has two plastic tabs at the
bottom and a screw at the top.

• With the device tilted as shown, hook
the plastic tabs into the notches at the
bottom of the base.

• Gently push the top of the module
toward the base until the back of the
module is flush with the base.

• Tighten the screw at the top of the
device to secure it to the base.

Spring loaded
securing screw
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DL205 Power Wiring and Grounding

The power wires for the DL205 are not connected directly to the H2–EBC as they are
on the H4–EBC. The DL205 power supply is an integral part of the base and
separate from the EBC. The DL205 also has three power options: 12/24VDC,
125VDC, and 120/240VAC.

The diagram shows the terminal
connections located on the power supply
of the DL205 bases. The base terminals
can accept up to 16 AWG. You may be
able to use larger wiring depending on
the type of wire used, but 16 AWG is the
recommended size.

NOTE: You can connect either a
120 VAC or 240 VAC supply to the AC
terminals. Special wiring or jumpers are
not required as with some of the other
DirectLOGIC products.

110/220 VAC Base Terminal Strip

85 – 264 VAC

G

24 VDC OUT
0.2A

125 VDC Base Terminal Strip

90 – 264 VDC

G

24 VDC OUT
0.2A

12/24 VDC Base Terminal Strip

12 – 24 VDC

G
D2–09BDC–2
range is
115–264 VDC

–

+

–

+

–

+

–

+

WARNING: Once the power wiring is connected, install the plastic protective cover.
When the cover is removed there is a risk of electrical shock if you accidentally touch
the wiring or wiring terminals.
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H4–EBC Power Wiring and Grounding

The power connection terminals are under the front cover of the Ethernet Base
Controller. The list below describes the function of each of the terminal screws.

• Relay – normally-open contact indicates that the EBC’s link to hub or
PC is good. Link Good indicator light is also on.

• 24VDC Auxiliary Power – can be used to power field devices or I/O
modules requiring external power. It supplies up to 400 mA of current at
20–28VDC, ripple less than 1 V P-P.

• Logic Ground – internal ground to the system which can be tied to field
devices or communication ports to unite ground signals.

• Chassis Ground – where earth ground is connected to the unit.

• AC Power –where the line (hot) and the neutral (common) connections
are made to the EBC.

• 110/220 Voltage Select – a jumper across two of the terminals
determines the voltage selection. Install the jumper to select 110VAC
input power, or remove the jumper to select 220VAC power input.

WARNING: Damage will occur to the power supply if 220 VAC is connected to the
terminal connections with the 115 VAC jumper installed. Once the power wiring is
connected, install the protective cover to avoid risk of accidental shock.

The following diagram shows the appropriate connections for each terminal. Note
that you should install a jumper between logic ground and chassis ground for best
noise immunity.

Install jumper for 110 VAC,
leave off for 220 VAC.
See Warning above.

110/220 VAC
Terminal Strip

Relay

24V Auxiliary
Power

Logic Ground

Chassis
Ground

110/220
Voltage Select

AC Line

AC Neutral

Install jumper between logic
and chassis ground for best

noise immunity if using
D4–0X–1 type base.

EBC Wiring
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10BaseT Network Cabling

Two types of EBC modules are available. One type supports the Ethernet 10BaseT
standard, and the other supports the 10BaseFL standard. The 10BaseT standard
uses twisted pairs of copper wire conductors, and the 10BaseFL standard is for fiber
optic cabling.

H4–EBCH2–EBC

RJ45
for
10BaseT

RJ12
Serial
Port
RS232

RJ12
Serial
Port
RS232

RJ45
for
10BaseT

The EBC has an eight-pin modular jack that accepts RJ45 connector plugs. UTP
(Unshielded Twisted-Pair) cable is rated according to its data-carrying ability
(bandwidth) and is given a category number. We strongly recommend using a
Category 5 (CAT5) cable for all Ethernet 10BaseT connections. For convenient and
reliable networking, we recommend that you purchase commercially manufactured
cables (cables with connectors already attached).

To connect an EBC (or PC) to a hub or repeater, use a patch cable (sometimes
called a straight-through cable). The cable used to connect a PC directly to an EBC
or to connect two hubs is referred to as a crossover cable.

RJ45 RJ45

TD–   2
TD+   1

RD+   3
4
5

RD–   6
7
8

GRN

GRN/WHT

OR/WHT
OR

BLU
BLU/WHT

BRN/WHT
BRN

GRN
GRN/WHT

OR/WHT

OR

BLU
BLU/WHT

BRN/WHT
BRN

Patch (Straight–through) Cable

2   
1   

3   
4
5
6   
7
8

RJ45 RJ45

TD–   2
TD+   1

RD+   3
4
5

RD–   6
7
8

GRN

GRN/WHT

OR/WHT
OR

BLU
BLU/WHT

BRN/WHT
BRN

GRN

GRN/WHT

OR/WHT
OR

BLU
BLU/WHT

BRN/WHT
BRN

This diagram illustrates the standard wire positions in the RJ45 connector.
We recommend all EBC 10BaseT cables to be Category 5, UTP cable.

Crossover Cable

EBC HUB EBC PC

2   TD–
1   TD+

3   RD+
4
5
6   RD–
7
8

TD–   

TD+   

RD+   
RD–   

NOTE: See page 2–10 for 10BaseT distance limitations.

EBC Supports Two
Standards

10BaseT
Connections

3 4 5 621 87

8-pin RJ45 Connector
(8P8C)

10BaseT
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10BaseFL Network Cabling
Two types of EBC modules are available. One type supports the Ethernet 10BaseT
standard, and the other supports the 10BaseFL standard. The 10BaseT standard
uses twisted pairs of copper wire conductors, and the 10BaseFL standard is for fiber
optic cabling.

H4–EBC H4–EBC–F

RJ12
Serial
Port
RS232

ST-style
Bayonet
for
10BaseFL

RJ12
Serial
Port
RS232

ST-style
Bayonet
for
10BaseFL

Each module has two ST-style bayonet connectors. The ST-style connector uses a
quick release coupling which requires a quarter turn to engage or disengage. The
connectors provide mechanical and optical alignment of fibers.

Each cable segment requires two strands of fiber: one to transmit data and one to
receive data. The ST-style connectors are used to connect the H4–EBC–F module
to a PC or a fiber optic hub or repeater.

The H4–EBC–F module accepts 62.5/125 multimode fiber optic (MMF) cable. The
glass core diameter is 62.5 micrometers, and the glass cladding is 125 micrometers.
The fiber optic cable is highly immune to noise and permits communications over
much greater distances than 10BaseT.

Transmit

Receive

Multimode Fiber Optic (MMF) Cable

62.5/125 MMF cable with
bayonet ST-style connectors

Transmit Transmit

Receive Receive

Connecting your fiber optic
EBC to a network adapter
card or fiber optic hub

NOTE: See page 2–10 for 10BaseFL distance limitations.

EBC Supports Two
Standards

10BaseFL
Connections

Fiber Optic Cable

Fiber Optic Module
ST Connector
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Maximum Ethernet Cable Length

The maximum distance per 10BaseT cable segment is 100 meters or 328 feet.
Repeaters extend the distance. Each cable segment attached to a repeater can be 100
meters. Two repeaters connected together extend the total range to 300 meters.

100 meters
(328 feet)100 meters

(328 feet)

100 meters
(328 feet)

100 meters
(328 feet)

100 meters
(328 feet)

Repeaters
Between

10BaseT Distance Limitations

The maximum distance per 10BaseFL cable segment is 2,000 meters or 6,560
feet. Repeaters extend the distance. Each cable segment attached to a repeater can be
2,000 meters. Two repeaters connected together extend the total range to 6,000 meters.

2,000 meters

Repeaters
Between

10BaseFL Distance Limitations

2,000 meters

2,000 meters
(6,560 feet)2,000 meters

2,000 meters

(6,560 feet)

(6,560 feet)(6,560 feet)

(6,560 feet)



Installation and
S

afety G
uidelines

Installation
and S

etup
2–11

Installation and Setup

Calculating the Power Budget for the DL205 with H2–EBC

When determining which I/O modules you will be using in the DL205 EBC system, it
is important to remember that there is a limited amount of power available from the
power supply. We have provided a table showing the power available from the
various DL205 base power supplies and a table showing the maximum power
consumed by the EBC and each of the I/O modules supported by the EBC. Following
these two tables is an example of a completed power budgeting worksheet and then
a blank worksheet you can use for your own calculations.

If the I/O modules you choose exceed the maximum power available from the
smaller DL205 base power supplies, you will need to use a D2–09B 9-slot base. This
base supplies more power than the other bases, as you can see in the table below.

WARNING: It is extremely important to calculate the power budget. If you exceed
the power budget, the system may operate in an unpredictable manner which may
result in a risk of personal injury or equipment damage.

The following table shows the amount of electrical current available at the two
voltages supplied from the DL205 base. Use these values when calculating the
power budget for you system.

The Auxiliary 24V power source mentioned in the table is available at the base
terminal strip. You can connect to external devices or DL205 I/O modules that
require 24VDC, but be sure not to exceed the maximum current supplied.

Bases 5V Current Supplied Auxiliary 24VDC
Current Supplied

D2–03B 1550 mA 200 mA

D2–04B 1550 mA 200 mA

D2–06B 1550 mA 200 mA

D2–09B 2600 mA 300 mA

D2–03BDC–1 1550 mA None

D2–04BDC–1 1550 mA None

D2–06BDC–1 1550 mA None

D2–09BDC–1 2600 mA None

D2–03BDC–2 1550 mA 200 mA

D2–04BDC–2 1550 mA 200 mA

D2–06BDC–2 1550 mA 200 mA

D2–09BDC–2 2600 mA 300 mA

The chart on the next page shows the maximum amount of electrical current
required to power each of the DL205 EBC or I/O modules. Use these values when
calculating the power budget for your system.

Managing your
Power Resource

EBC Power
Specifications

Module Power
Requirements
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Power Consumption Chart (DL205 Modules)

Module 5V Power
Required (mA)

External Power Source Required

CPUs

D2–230 120 None

D2–240 120 None

D2–250 330 None

DC Input Modules

D2–08ND3 50 None

D2–16ND3–2 100 None

D2–32ND3/–2 25 None

AC Input Modules

D2–08NA–1 50 None

D2–08NA–2 100 None

D2–16NA 100 None

DC Output Modules

D2–04TD1 60 20

D2–08TD1 100 None

D2–16TD1–2 200 24 VDC @ 80 mA max

D2–16TD2–2 200 0

D2–32TD1/2 350 0

AC Output Modules

D2–08TA 250 None

D2–12TA 350 None

Relay Output Modules

D2–04TRS 350 None

D2–08TR 250 None

D2–12TR 450 None

F2–08TR 670 None

F2–08TRS 670 None

Combination Modules

D2–08CDR 200 0

Analog

F2–04AD–1(L) 50 18–30 VDC @ 80 mA max; (–L) 10–15VDC @ 90mA

F2–04AD–2(L) 60 18–26.4 VDC @ 80 mA max; (–L) 10–15VDC @ 90mA

F2–08AD–1 50 18–26.4 VDC @ 80 mA max

F2–08AD–2 60 18–26.4 VDC @ 80 mA max

F2–02DA–1(L) 40 18–30VDC @ 60mA; (L) 10–15VDC @ 70mA (add 20mA / loop)

F2–02DA–2(L) 40 18–30 VDC @ 60 mA max; (–L) 10–15VDC @ 70mA

F2–02DAS–1 100 18–32VDC @ 50mA per channel

F2–02DAS–2 60 21.6–26.4 VDC @ 60 mA per channel

F2–08DA–2 60 18–30 VDC @ 80 mA max

F2–04AD2DA 110 18–26.4VDC @ 80mA; add 20mA / loop

F2–04RTD 90 0

F2–04THM 110 18–26.4 VDC @ 60 mA max

Specialty Modules

D2–CTRINT 50 5 VDC @ 60 mA max (required for outputs only)
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The following example shows how to calculate the power budget for the DL205
system.

Base #

          1           

Module Type 5 VDC (mA) Auxiliary
Power Source
24 VDC Output
(mA)

Available
Base Power

D2–09B 2600 300

EBC H2–EBC +  530 +      0

Slot 0 D2–16ND3–2 +  100 +      0

Slot 1 D2–16NA +  100 +      0

Slot 2 D2–16NA +  100 +      0

Slot 3 F2–04AD–1 +    50 +    80

Slot 4 F2–02DA–1 +    40 +    100

Slot 5 D2–08TA +  250 +      0

Slot 6 D2–08TD1 +  100 +      0

Slot 7 D2–08TR +  250 +      0

Other

Maximum Power Required 1520 180

Remaining Power Available 2600–1520= 1080 300 – 170        =  120

1. Using the table on the previous page, fill in the information for the base
power supply, the EBC, I/O modules, and any other devices that will use
system power including devices that use the 24 VDC output. Pay special
attention to the current supplied by the base power supply. The 9-slot base
has a larger current capacity than the smaller bases.

2. Add the current columns starting with the row for Slot 0 and working your
way down to the “Other” category. Put the total in the row labeled
“Maximum power required”.

3. Subtract the row labeled “Maximum power required” from the row labeled
“Available Base Power”. Place the difference in the row labeled
“Remaining Power Available”.

4. If “Maximum Power Required” is greater than “Available Base Power” in
either of the two columns, the power budget will be exceeded. It will be
unsafe to use this configuration, and you will need to restructure your I/O.
You may need to a 9-slot base to accommodate your current requirements.

Power Budget
Calculation
Example
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This blank chart is provided for you to copy and use in your power budget
calculations.

Base #

          0           

Module Type 5 VDC (mA) Auxiliary
Power Source
24 VDC Output (mA)

Available
Base Power

CPU Slot

Slot 0

Slot 1

Slot 2

Slot 3

Slot 4

Slot 5

Slot 6

Slot 7

Other

Total Power Required

Remaining Power Available

1. Using the table on the previous page, fill in the information for the base
power supply, the EBC, I/O modules, and any other devices that will use
system power including devices that use the 24 VDC output. Pay special
attention to the current supplied by the base power supply. The 9-slot base
has a larger current capacity than the smaller bases.

2. Add the current columns starting with the row for Slot 0 and working your
way down to the “Other” category. Put the total in the row labeled
“Maximum power required”.

3. Subtract the row labeled “Maximum power required” from the row labeled
“Available Base Power”. Place the difference in the row labeled
“Remaining Power Available”.

4. If “Maximum Power Required” is greater than “Available Base Power”
in either of the two columns, the power budget will be exceeded. It will be
unsafe to use this configuration, and you will need to restructure your I/O.
You may need to a 9-slot base to accommodate your current requirements.

Power Budget
Calculation
Worksheet
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Calculating the Power Budget for the H4–EBC(–F)

When determining which I/O modules you will be using in the DL405 EBC system, it
is important to remember that there is a limited amount of power available from the
power supply. We have provided a table showing the power available from the
H4–EBC and H4–EBC–F or Expansion Unit power supplies and a table showing the
maximum power consumed by each of the I/O modules supported by the EBC.
Following these two tables is an example of a completed power budgeting
worksheet and then a blank worksheet you can use for your own calculations.
If the I/O modules you chose exceed the maximum power available from the power
supply you can resolve the problem by shifting some of the modules to an expansion
base which contains another power supply.

WARNING: It is extremely important to calculate the power budget correctly. If you
exceed the power budget, the system may operate in an unpredictable manner
which may result in a risk of personal injury or equipment damage.

The following chart shows the amount of electrical current available at the two
voltages supplied by the EBCs and Expansion units. Use these current values when
calculating the power budget for your system.
The Auxiliary 24VDC Power Source mentioned in the table is available at the
H4–EBC terminal strip (see page 2–7). You can use this power source to connect to
external devices or DL405 I/O modules that require 24VDC.

CPUs 5VDC Current
Supplied in mA.

Auxiliary 24VDC Power
Source Current
Supplied in mA.

H4–EBC 3470 400

H4–EBC–F 3330 400

Expansion Units 5VDC Current
Supplied in mA.

Auxiliary 24VDC Power
Source Current
Supplied in mA.

D4–EX 4000 400

The chart on the next page shows the maximum amount of electrical current
required to power each of the DL405 I/O modules. Use these values when
calculating the power budget for your system.

Managing your
Power Resource

EBC and
Expansion Base
Power
Specifications

Module Power
Requirements
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Power Consumption Chart (DL405 Modules)

Device 5V Current
Required (mA)

External 24V
Current Req. (mA)

Device 5V Current
Required (mA)

External 24V
Current Req. (mA)

I/O Bases AC Output Modules

D4–04B, D4–04BNX,
D4–04B–1

80 None D4–08TA 250 None

D4–06B, D4–06BNX,
D4–06B–1

80 None D4–16TA 450 None

D4–08B, D4–08BNX,
D4–08B–1

80 None Relay Output Modules

DC Input Modules D4–08TR 550 None

D4–08ND3S 100 None F4–08TRS–1 575 None

D4–16ND2 150 None F4–08TRS–2 575 None

D4–16ND2F 150 None D4–16TR 1000 None

D4–32ND3–1 150 None Analog Modules

D4–32ND3–2 150 None D4–04AD 200 200

D4–64ND2 300 (max) None F4–04AD 85 100

AC Input Modules F4–04ADS 270 120

D4–08NA 100 None F4–08AD 75 90

D4–16NA 150 None D4–02DA 250 300

AC/DC Input Modules F4–04DA 120 180

D4–16NE3 150 None F4–04DA–1 70 75 + 20 per circuit

F4–08NES 90 None F4–04DA–2 70 75 + 20 per circuit

DC Output Modules F4–08DA–1 70 100 + 20 per circuit

D4–08TD1 150 35 F4–16DA–1 70 100 + 20 per circuit

F4–08TD1S 295 None F4–08THM–n 120 50 + 20 per circuit

D4–16TD1 200 125 F4–08RTD 80 None

D4–16TD2 400 None Specialty Modules

D4–32TD1 250 140 D4–HSC 300 None

D4–32TD1–1 250 140 (5–15VDC) D4–16SIM 150 None

D4–32TD2 350 120 / (4A max
including loads)

D4–64TD1 800 (max) None
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The following example shows how to calculate the power budget for the DL405
system.

Base #

          1
Module Type 5 VDC (mA)

Auxiliary
Power Source
24 VDC Output (mA)

EBC/
Expansion
Unit

H4–EBC 3470 400

Slot 0 D4–16ND2 +  150 +      0

Slot 1 D4–16ND2 +  150 +      0

Slot 2 D4–02DA +  250 +  300

Slot 3 D4–08ND3S +  100 +      0

Slot 4 D4–08ND3S +  100 +      0

Slot 5 D4–16TD2 +  400 +      0

Slot 6 D4–16TD2 +  400 +      0

Slot 7 D4–16TR + 1000 +      0

Base D4–08B +   80 +      0

Other

Maximum power required 2630 300

Remaining Power Available 3470–2630 = 840 400 – 300        =  100

1. Using the table on the previous page, fill in the information for the
EBC/Expansion Unit, I/O modules, and any other devices that will use
system power including devices that use the 24 VDC output. Pay special
attention to the current supplied by the H4–EBC, the H4–EBC–F or the
Expansion Unit. Each one supplies a different amount of current.

2. Add the current columns starting with the row for Slot 0 and working your
way down to the “Other” category. Put the total in the row labeled
“Maximum power required”.

3. Subtract the row labeled “Maximum power required” from the row labeled
“EBC/Expansion Unit”. Place the difference in the row labeled
“Remaining Power Available”.

4. If “Maximum Power Required” is greater than “EBC/Expansion Unit” in
either of the two columns, the power budget will be exceeded. It will be
unsafe to use this configuration, and you will need to restructure your I/O.
You may need to add expansion bases to accommodate your current
requirements.

Power Budget
Calculation
Example
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You may copy and use the following blank chart for your power budget calculations.

Base # Module Type 5 VDC (mA) Auxiliary
Power Source
24 VDC Output (mA)

EBC/
Expansion
Unit

Slot 0

Slot 1

Slot 2

Slot 3

Slot 4

Slot 5

Slot 6

Slot 7

Base

Other

Maximum Power Required

Remaining Power Available

1. Using the tables at the beginning of the Power Budgeting section of this
chapter fill in the information for the EBC/Expansion Unit, I/O modules, and
any other devices that will use system power including devices that use the
24 VDC output. Pay special attention to the current supplied by the
H4–EBC, the H4–EBC–F or the Expansion Unit since they do differ.

2. Add the current columns starting with the row for Slot 0 and working your
way down to the “Other” category. Put the total in the row labeled
“Maximum power required”.

3. Subtract the row labeled “Maximum power required” from the row labeled
“EBC/Expansion Unit”. Place the difference in the row labeled
“Remaining Power Available”.

4. If “Maximum Power Required” is greater than “EBC/Expansion Unit” in
either of the two columns, the power budget will be exceeded. It will be
unsafe to use this configuration, and you will need to restructure your I/O.
You may need to add expansion bases to accommodate your current
requirements.

Power Budget
Calculation
Worksheet
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DL405 Local and Expansion I/O

The H4–EBC supports the use of DL405 series I/O local and local expansion bases.

The local base is the base in which the
EBC resides. Local I/O modules reside in
the same base as the EBC. For example,
placing 32-point modules in all eight slots
in an 8-slot base will use 256 I/O points .

����
�����

���
�����

	
��
�����

����
������

���
������

����
������

� � � � � �
EBC

Use local expansion bases when you need more I/O points or a greater power
budget than the local base provides. The expansion bases require a Local
Expansion Unit (rather than an EBC) and a cable (either D4–EXCBL–1 or
D4–EXCBL–2) to connect to the local EBC base.
The following figure shows one EBC base and three expansion bases. The I/O
modules are shown as examples of a usable configuration, but any configuration of
I/O modules could be used if it is supported by the power budget. See page 2–15 for
information about calculating the power budget.
The H4–EBC supports one local base and a maximum of three expansion bases.

The H4–EBC(–F)
supports up to three

expansion bases.

Local Base and I/O

Local Expansion
Base and I/O



Configuring the EBC
Using NetEdit

In This Chapter. . . .
— Starting NetEdit Software
— Using NetEdit
— Using NetEdit to Configure the DL405 Base
— Locating the Ethernet Address Label
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Using NetEdit

Starting NetEdit Software

NetEdit is a software utility which can be used to select the Ethernet communication
protocol, to set the Module ID for the EBC, and to perform diagnostic and
troubleshooting tasks. It can also be used to configure the serial port and to
configure the DL405 base.

You can run NetEdit on Windows 95/98�, Windows NT�, or Windows 2000�,
Windows ME�. NetEdit will run directly from your 3.5” floppy disk drive.

To run the NetEdit program,
insert the NetEdit 3.5” floppy
disk into drive A: (or the
appropriate drive for your PC).
Click on the Start button and
selct Run...from the pop–up
window, enter the letter of the
drive, colon, backslash and the
name NetEdit, and click OK.

c:\netedit

If you prefer, you can copy the NetEdit files from the 3.5” floppy disk to your hard
drive. In Windows Explorer, locate the following three files on the floppy disk:

• Hei32_2.dll

• Netedit.exe

• Netedlib.dll

Copy all three files to a single directory on your hard drive, and start NetEdit by
double clicking on NetEdit.exe.

Starting NetEdit brings up the screen below. All NetEdit functions are accessed from
this screen.

Operating System
Requirements

System
Requirements

The NetEdit
Screen
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Using NetEdit

In this section, we will step through the features and uses of NetEdit. We will describe
the individual segments of the NetEdit screen and the function of each. If you need to
refer to the full screen, you can start NetEdit as described on page 3–2, or you can
refer to the figure at the bottom of page 3–2.

NOTE: Your PC-based Control software may be capable of configuring the EBC
module. If so, please refer to the appropriate documentation for that software
product to determine the best method to configure the EBC. The use of Think & Do
software to configure the EBC is discussed in Appendices B and C of this manual.

In the upper left corner of the NetEdit screen, you will find a box labeled Protocol. In
the box, there are two choices: IPX and UDP/IP. The EBC module understands IPX
and UDP/IP protocols. Both protocols are permanently resident in the firmware of
the module.
When you click on one of these radio buttons, you are selecting the protocol you
want your PC to use to communicate with the EBC module. You are not telling the
module which protocol to use, because it is using both protocols all the time. IPX is a
Novell standard in widespread use, and UDP/IP is a popular protocol supported by
the TCP/IP suite of protocols in your PC.

The figure to the right shows the
Protocol selection box in the upper left
corner of the NetEdit screen. The
choice you make here tells your PC
which protocol to send to the EBC to
link NetEdit to the module. You are not
selecting which protocol the EBC
understands. It understands both.

Some PC-based control software
products may support only one of
these protocols. Read the
documentation for your software to be
sure the protocol you select is
supported.

NOTE: We strongly recommend you load IPX protocol on your PC and use it for your
PLC links. Use UDP/IP in your application, if required, but also add IPX to your list of
active protocols. Having IPX loaded on your PC gives you a backup for
troubleshooting communication problems.

Ethernet
Communication
Protocol
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Using NetEdit

You may have already set up your PC with selected networking protocols for
Ethernet communications. If not, you will need to select the protocols now for
communication with the EBC module. We strongly recommend that you include the
IPX protocol. From My Computer on your PC Desktop, go to Control Panel. Double
click on Network, then click on the Protocols tab. If IPX is not listed among the
protocols already loaded, add it now by clicking on the Add... button. The Select
Network Protocol window will pop up (see figure below).

Add the TCP/IP protocol if it is necessary for your application. The TCP/IP selection
will give you support for the UDP/IP protocol. Also, add the IPX protocol if it is not
already active.

→

→

The lower left corner of the NetEdit
screen displays the Ethernet
Address of the modules currently on
the network.

If modules are added or removed from
the network, click on the Query
Network button to update the list.
Notice that the Ethernet Address is the
factory-assigned address that is on the
permanent label on the module. See
page 3–8.

Select a specific module here by
clicking on the Ethernet Address or by
using the arrow keys. The selected
module is highlighted.

NOTE: The Module box lists the Ethernet Addresses of Ethernet Base Controllers
(EBCs) and Ethernet Communications Modules (ECOMs). This manual covers the
use of NetEdit for assigning a Module ID to EBCs only.

Adding Network
Protocol Support
to Your PC

Ethernet Address
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Using NetEdit

The Module Information box gives the
Type and the Version number. The Type is
the catalog number of the module. The
Version refers to the firmware version.

This box is in the top middle of the NetEdit
screen.

NOTE: The module information and settings on this page apply to the selected
(highlighted) module. To select a module, click on its Ethernet Address in the Module
box. See page 3–4 for more information about selecting a module.

The Ethernet Stats are statistics related to
communication errors. These statistics are
explored in Chapter 4, Maintenance and
Troubleshooting.

Click on the Clear Stats button to reset all
categories to 0 (zero).

The Configuration box allows you to
assign a Module ID. Module IDs must be
unique for each EBC, but they do not have
to be in sequence. The DIP switches must
all be set to zero to enable any software to
change the Module ID. Do not use
address zero for communications.

The Name field and Description field are
optional.

To set an IP Address, highlight the
number in each of the four boxes, and
overwrite the number. Use the
twelve-digit number assigned to the EBC
module by your network administrator. If
you change the IP Address, do not use the
number “255” in any field. Doing so will
cause communication problems.

The Update Module button sends all
entries to the module’s flash memory. The
Advanced Settings button displays a
pop-up window described on the next
page.

Module
Information

Module ID
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Using NetEdit

Clicking on the Serial Port button (right)
causes the Serial Port Settings screen to
pop up.

Clicking on the Base Configuration button
causes the EBC Base Configuration
screen to appear.

The Advanced Settings button in the Configuration box of Net Edit (page 3–5)
brings up the EBC Advanced Settings window.

On the Serial Port Settings screen, make
any necessary changes to the serial
communication parameters. After making
changes, be sure to click on the Update
Module button. Also, Be sure these
parameters match the parameters of the
serial device with which you are
communicating.

Note: Some PC-based Control software
packages may automatically overwrite
settings selected here. Refer to the
documentation for your PC-based Control
software.

When you click on the Base Configuration button (top of page) the H4–EBC Base
Configuration screen pops up, as shown (immediately above). The H2–EBC is
self-configuring and does not require this step.

Advanced
Settings
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Using NetEdit to Configure the H4–EBC Base

NOTE: The following configuration information applies only to the H4–EBC(–F) and
the DL405 I/O. The H2–EBC(–F) and associated DL205 I/O are self-configuring and
do not require this additional step.

The default symbol “----------” appears on the configuration screen where digital or
analog modules are present. For digital modules, you do not need to make any
changes. The H4–EBC recognizes the digital modules and is self-configuring for the
digital modules.
If you are using analog modules, you must let the H4–EBC know that by doing the
following. Click on the slot location where the analog module is located. Continue
clicking on the same slot location until the part number of your analog module
appears.

Once the correct part numbers appear for each of your analog modules, click the
Update Module button to save the configuration into flash memory onboard the
module. Leave the symbol “----------” wherever you have a digital module.
If you are using a High Speed Counter module, the word “Intelligent” will appear in
gray. The High Speed Counter module is configured automatically (see below). No
other action is required other than clicking on the Update Module button.

Configuring
Analog Modules

Configuring the
High Speed
Counter Module
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Using NetEdit

Locating the Ethernet Address Label

Host Auto Prod
H4–EBC
00 E0 62 00 00 85

Host Auto Prod
H2–EBC
00 E0 62 00 00 84

Factory-assigned Ethernet Address

A unique Ethernet Address is assigned to each module at the factory and cannot be
changed. It is a twelve digit number, and it is printed on a label permanently attached
to the EBC module. NetEdit recognizes the Ethernet Address

Ethernet Address



Troubleshooting

In This Chapter. . . .
— Isolating a Communication Problem
— Troubleshooting Chart
— EBC Module Diagnostic LEDs
— Using NetEdit for Troubleshooting
— Diagnosing Network Cable Problems
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Troubleshooting Guidelines

Isolating a Communication Problem

If you are experiencing a problem communicating with an EBC module, the problem
can usually be isolated to one of four components of the communication link:

• the EBC module itself (hardware or firmware)
• the communication program or the setup of the EBC module
• the cabling and connections
• other external influences, such as electrical noise, heavy communication

traffic on the network or exceeding the PLC power budget

Several available tools and techniques can help you isolate a communication
problem:

• The LEDs on the face of the module indicate the status of the link, the
module, and the network communications.

• Replacing the module may determine whether the problem is in the
module.

• NetEdit displays a list of the active modules on the network and their
protocol and configuration settings.

• Cable testing devices can pinpoint short or open circuits or diagnose
attenuation problems and other cabling problems.

• Diagnostic tools within your PC-based Control software.

Troubleshooting Chart

The following chart summarizes the different types of communication failures you
could experience. In each case the CPU PWR LED must be on, and you must be
attempting to communicate with the EBC in question.

The meaning of the diagnostic LEDs is explained on page 4-4.

EBC Module LEDs Corrective Action
ÈÈOff On FlashLegend:

Troubleshooting Chart

LINKGD
ACT

ERROR

1. Cycle power to the base. This will clear
the ERROR if it was due to a transient
condition.
2. Replace EBC module

ÈÈ

LINKGD
ACT

ERROR
OR

Diagnostic Tools
and Techniques
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EBC Module LEDs Corrective Action

ÈÈ
ÈÈ

Off On FlashLegend:

Troubleshooting Chart (Continued)

LINKGD
ACT

ERROR

1. Try another cable that you know works.
Check pinouts (see page 2–8).

3. Replace EBC module.

2. Try another port on the hub or
another hub.

LINKGD
ACT

ERROR

1. Try another cable between PC and hub.

4. Could be related to Windows configura-
tion. Consult Windows documentation.

2. Try another port on the hub or another
hub.

3. Make sure you have not exceeded the
recommended cable length for your
network cable. The link signal could
arrive with sufficient strength even
though the data transmission does not.

ÈÈ
ÈÈ

LINKGD
ACT

ERROR

1. Try another cable between PC and hub
or EBC and hub.

2. Try another port on the hub or another
hub.

3. Look for errors in the setup of the EBC
module.

Note: This is also the indication of proper
operation! Troubleshoot only if you are
failing to exchange data.

OR
LINKGD

ACT
ERROR
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EBC Module Diagnostic LEDs

The EBC module has three indicator lights which show the status of the following:
• signal path between the EBC and the hub
• signal between a PC and an EBC
• EBC module hardware

LINKGD

ACT
ERROR

ERROR

LINK GOOD

ACTIVITY

H2–EBC H4–EBC

The green LINKGD (LINK GOOD) LED is on steady when the EBC module is
connected  properly to an active device on the network and is receiving 5VDC
operating voltage from the PLC power supply. The LINKGD LED verifies that the
proper cables are connected, and the EBC module is functioning correctly. If a
mismatch with the 10BaseT or 10BaseFL connections occurs this LED will not be
illuminated.

The red ACT (ACTIVITY) LED flashes to indicate that the module is detecting data
on the network. If any network device is sending or receiving data, the ACT LED will
be illuminated. In idle mode (no network traffic) this LED is OFF. During heavy
communication loads this LED will be on steady.

If the EBC module’s red ERROR indicator is flashing or on steady, a fatal error has
occurred. The error may be in the EBC module itself, or a network problem may be
causing this symptom. The ERROR indication can be caused by a faulty ground, an
electrical spike or other types of electrical disturbances. Cycle power to the system
to attempt clearing the error.

EBC LEDs

LINK GOOD
Indicator

ACTIVITY Indicator

ERROR Indicator
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Using NetEdit for Troubleshooting

NetEdit is a software utility which came with this manual. To review the procedures
for running and using NetEdit, see Chapter 3. NetEdit allows you to:

• See active modules on the network.
• Examine and change the modules’ configuration settings.
• See the firmware revision number.
• Review statistical information about communication errors by type.

The Module box shows the Ethernet
Addresses of all modules which are
currently linked to the NetEdit utility. If your
EBC module is not on this list, try the
following:

• Change Protocol selection and click on
Query Network. See Change
Protocol on the next page.

• Confirm that your PC has IPX or
TCP/IP protocol loaded.

• Confirm that the EBC module’s Link
Good LED is on.

NOTE: The Ethernet Address is permanently assigned at the factory, and it is
recorded on a label on the side of the EBC module. See page 3–8 if you need help
locating the label.

The Module Information box is updated with
module type and version for the module
currently selected. Verify that all modules
of the same type (H2 or H4) have the same
firmware version.

Select a Module

Module Information
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If you are experiencing a problem
communicating from your PC to a module
that does not appear on the list of active
modules, try changing the protocol and
clicking on Query Network. You may be
able to link to your module with the other
protocol.
If you are not sure which protocol driver is loaded on your PC, refer to page 3–4, as
well as your Windows NT� documentation.
If you are able to see the problem module on
the list of modules currently active on the
network, you can select the module to see
the Ethernet Stats for that module. Select
the module by clicking on the Ethernet
Address in the Module box (see page 3–4).
To begin a new statistical record, click the
Clear Stats button.
The diagnostic information available in the
Ethernet Stats box is:

• Missed Frames – frames lost
due to unavailability of buffer
space.

• TX Collisions – detected when
RXD+ and RXD– become active during a data transmission. Two
devices are trying to communicate at the same time.

• Lost Packets – packets that overflow the queue.
• Bad Packets – packets that fit the Ethernet standard but are not in the

right format for the EBC module.
• Unknown Type – a foreign command was received and could not be

interpreted. This will probably happen only during software driver
development.

• Send Errors – the Ethernet standard number of retries were attempted
for a transmission.

If you are replacing an existing EBC module with a new one, you need to set up the
new module with the same Module ID as the module you are replacing. If you used
the DIP switch to set the Module ID, you will need to set the DIP switch on the
replacement module to the same Module ID. See page 2–3 or 2–4 to review the
procedure for setting the Module ID using the DIP switch.
If you set up your original EBC module using NetEdit, you will need to duplicate the
settings in the new module using the same procedures. See page 3–2 through 3–7
to review the procedures for using NetEdit.
If you set up your original EBC module using your PC-based Control software, you
will need to refer to the appropriate documentation.

WARNING: Your system can be damaged if you install or remove system
components before disconnecting the system power. To minimize the risk of
equipment damage, electrical shock, or personal injury, always disconnect the
system power before installing or removing any system component.

Change Protocol

Ethernet Stats

Replacing the EBC
Module
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Diagnosing Network Cable Problems

If you are experiencing communication problems, swapping cables is one of the
simplest diagnostic procedures you can perform. If the network operates correctly
with a different cable, you have isolated and cured the problem. If possible, use a
short run of cable to test the network because problems with longer cable runs can
be more difficult to diagnose and are more often intermittent.
If you are unable to swap cables, verify the proper operation of all other network
components. You probably have a cable problem if you have verified that your:

• EBC module is working correctly.
• EBC module configuration is correct.
• RLL program or PC program is correct.
• hubs are working correctly.
• Windows configuration is correct.
• network adapter card is the correct type, and it is working correctly.

It is a good maintenance practice to test network cables periodically and maintain a
permanent record of cable characteristics. A number of cable test instruments are
available to test 10BaseT and 10BaseFL networks. These instruments will check the
electrical or optical characteristics of your cabling, including:

• Continuity – This is a check to make sure the communication pairs are
wired correctly, and that the wires are continuous from end to end. In the
case of fiber optic network this is a test to be sure light is transmitted
from one end of the cable to the other.

• Attenuation – This refers to the amount of signal loss over the cable
segment at the signal frequency of interest. The 10BaseT specification
allows for a maximum signal loss of 11.5 decibels (dB) for the entire link
at the signal frequency used by 10Mbps Ethernet. The 10BaseFL
specification calls for the optical loss in link segment to be no greater
than 12.5 dB.

• Crosstalk – Crosstalk occurs when a signal in one pair of wires is
electromagnetically coupled to an adjacent pair. This is critical
for10BaseT networks which are susceptible to noise interference.
10BaseFL networks are virtually immune to noise interference.

NOTE: Any significant difference between the cable characteristics of the
transmitter and receiver can cause communication errors.

Ethernet devices continually monitor the “receive data” path for activity as a means
of verifying their link is working correctly. When the network is idle, each network
device (including the EBC module) sends a periodic link test signal to verify that the
network is working. If the link test signal or other network activity is not received
periodically, the Link Good LED on the EBC module is turned off.
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General Specifications

H2–EBC(–F) and H4–EBC(–F) Specifications

H2–EBC H2–EBC–FSpecifications

Communications 10Base-T Ethernet 10Base-FL Ethernet
Data Transfer Rate 10Mbps 10Mbps
Link Distance 100 meters (328 ft) 2,000 meters (6,560 ft)
Ethernet Port RJ45 ST-style fiber optic
Ethernet Protocols TCP/IP, IPX

Power Consumption

TCP/IP, IPX

530mA 670mA
Manufacturer Host Automation Prods Host Automation Prods

Serial Port RJ12, K-sequence RJ12, K-sequence

H4–EBC H4–EBC–FSpecifications

Power Supplied 3470mA @ 5VDC 3330mA @ 5VDC

Manufacturer Host Automation Prods Host Automation Prods

Ethernet Port RJ45 ST-style fiber optic

Serial Port RJ12, K-sequence RJ12, K-sequence
Ethernet Protocols TCP/IP, IPX TCP/IP, IPX

Communications
Data Transfer Rate 10Mbps 10Mbps
Link Distance 100 meters (328 ft) 2,000 meters (6,560 ft)

10BaseT Ethernet 10BaseFL Ethernet

400mA @ 24VDC 400mA @ 24VDC

Serial Port Specifications

Serial Port Pin Descriptions
1 0V Power (–) connection (GND)
2 5V Power (+) connection
3 RXD Receive Data (RS232C)
4 TXD Transmit Data (RS232C
5 RTS Request to Send
6 0V Power (–) connection (GND)

6-pin Female (RJ12)
Modular Jack

as oriented on EBC

�

�6-pin Male (RJ12)
Modular Plug

1 2 3 4 5 6
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Ethernet Standards

Various institutes and committees have been involved in establishing Ethernet data
communication standards. These specification standards assure Ethernet network
compatibility for products from a broad variety of manufacturers.
The EBC module complies with  American National Standards Institute (ANSI) and
Institute of Electrical and Electronic Engineers standard ANSI/IEEE 802.3, Carrier
Sense Multiple Access with Collision Detection (CSMA/CD) Access Methods and
Physical Layer Specifications. This standard has been adopted by the International
Organization for Standardization (ISO) as document ISO/IEC 8802–3.
The Electronic Industries Association (EIA) and Telecommunications Industries
Commercial Building Telecommunications Wiring Standard designated
EIA/TIA–568A defines implementation of 10BaseT (twisted pair) and 10BaseF
(fiber optics) for Ethernet communications.
The same two organizations produced EIA/TIA TSB40–Additional Transmission
Specifications for Unshielded Twisted-Pair Connecting Hardware. The purpose of
this document is to specify transmission performance requirements and connecting
hardware requirements.
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Using H2–EBC with Think & Do

Configuring the DL205 I/O Base
The H2–EBC(–F) and DL205 I/O are self-configuring. The H2–EBC(–F) reads the
module and identities it on powerup. Within the Think & Do I/O View tool, the DL205
I/O modules are graphically displayed as soon as a connection is established
between your PC and your H2–EBC(–F).
For additional information about establishing a connection between your PC and the
H2–EBC(–F), please see the Think & Do Software Learning Guide.

Mapping H2–EBC I/O Points
We recommend that you be familiar with “Getting Started” and “Creating a Project”
chapters in the Think & Do Studio Learning Guide before attempting to map the
EBC I/O points/channels to Data Items using ConnectivityCenter.

To launch ConnectivityCenter:
1) Launch Think & Do Studio ProjectCenter from the Windows desktop by  either
       clicking on Start, then Programs, next Think & Do Studio, finally
       ProjectCenter or click on the ProjectCenter icon to start.
2) Click on the File Menu and either open your Think & Do Project or select New.
3) Within ProjectCenter select Windows 2000 or NT Certified PC as the Runtime
      Target.
4) Then either click Tools, then ConnectivityCenter to launch the
    ConnectivityCenter or click on the ConnectivityCenter shortcut in the Project
      Explorer.
5) Once in ConnectivityCenter click on Drivers, then Add and select
      Automationdirect.com Ethernet I/O Driver.
5)Then either click on Configuration, then Connect or click on the Connect
     toolbar button.

ConnectivityCenter will draw a picture of your EBC I/O system.

Board View

Automationdirect.com
I/O Driver

This procedure is discussed in detail in the “Creating a Project” chapter in the Think
& Do Studio Learning Guide. This will map your real world I/O to Data Items.

Launching
Connectivity
Center Tool

Connecting
to the EBC

Mapping I/O Points
to Data Items
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I/O Module Status Word / Bits
I/O Module diagnostic information is listed for each I/O module under the Module
Status Mapping tab. Click on a module graphic to display its Status Item
Descriptions.

Status Indicator

Module Status Mapping Tab

1 = Error
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Using EZTouch/EZText Panel with the RJ–12 Serial Port
The H2–EBC has a built–in RS232C serial port that can be used to connect to an
operator interface panel. Use ConnectivityCenter to configure the connection from
the H2–EBC to the EZTouch or EXText panel. The “HMI Options for Remote Base
Controllers” section in the “Operator Screen Techniques” chapter in the Think & Do
Studio Learning Guide discusses configuring and using Optimate Panels with the
EBC.

Click on the H2–EBC graphic and Module Info tab in the ConnectivityCenter. The
Serial Port Settings attributes are all that will be visible in ConnectivityCenter when
the I/O is disconnected. Follow the steps below to configure the EBC’s RJ12 serial
port to be used with either the EZTouch or the EZText panels.

1. Click Here to access port settings.

4. Set the Family to
Modbus Master and
the Panel Type to
EZTouch/Text.

3. Click Add...

2. Check Enable Serial
   Port to enable
    the serial port. These
    settings must match
    the port configuration
    of the EZ panel.

Adding Operator
Interface Device
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Once the EZTouch or EZText panel has been added, it will show up in the list of the
configured devices, and an EZTouch/Text panel graphic symbol will be located
under the I/O base next to the EBC.

Re–connect to the I/O in ConnectivityCenter by either clicking on Configuration,
then Connect or by clicking on the Connect toolbar button. Then scan the I/O by
either clicking on Configuration, then Scan or by clicking on the Scan toolbar
button. Doubleclick on the EZ panel box graphic to launch the Monitor I/O Dialog
Box. The Monitor I/O tool allows the user to update the fields at any moment, altough
the panel continuously updates the fields with changes as well. All of the “Value”
fields in the Monitor I/O Dialog Box are read/write and are updated from the the
Monitor I/O Dialog box which takes precedence over updates from the panel.
The user can update bit values (Input, Output and Flag) immediately by one mouse
click or by pressing the space bar. 
When typing in numbers, the grid will enter the edit mode which will block any
conflicting updates from the panel. The edit mode entry is completed after pressing
Enter, any arrow key or by selecting a new line.

Monitor I/O
Dialog Box

Using Monitor I/O
to Verify Panel
Operation
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In This Appendix
— Configuring the DL405 I/O Base with H4–EBC(–F)
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Configuring the DL405 I/O Base with H4–EBC(–F)

Configuring the base is a necessary step in the setup of the H4–EBC module. The
H4–EBC must know the type and location of each input and output module installed
in the base. Once identified, the configuration resides in non-volatile memory
on-board the EBC until a change is made.
The H4–EBC is partially self-configuring. On powerup, the H4–EBC reads the base
to determine the specifications of installed modules. The information available
allows the H4–EBC to determine:

• whether the I/O modules are inputs or outputs
• whether the installed modules are standard I/O modules or a High

Speed Counter module (other intelligent modules are not supported at
this time)

If you are not using analog inputs or outputs the H4–EBC configures itself. For the
following module types, the DL405 I/O system provides the necessary configuration
information to the H4–EBC, and the H4–EBC automatically configures the base:

• digital inputs
• digital outputs
• High Speed Counter module

If you are using analog inputs or outputs you must configure the base manually
using a software utility imbedded in Think & Do:

You are ready to configure your base if you have done all of the following:
• installed your H4–EBC or H4–EBC–F module
• connected power wiring to the EBC terminal strip
• installed I/O modules and expansion bases as necessary for your

application
• connected your PC and EBCs to a dedicated Ethernet network
• installed Think & Do (Version 4.4, or later) on your PC

NOTE: The pages that follow explain how to use the Think & Do software utility for
configuring the base. For additional information about using the Think & Do software
product, please refer to the Think & Do Software Learning Guide.
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I/O View is one of the tools provided by
Think & Do software. It is directly accessi-
ble from the Start menu after installation.
Select Start, then Programs, then Think
& Do, then T&D I/O View, as shown to the
right.

The I/O View window will appear as
shown, with a blank I/O configuration
screen. If you save this screen without
renaming it, the default name will be
“IOView1”. 

We use a new I/O View window to
configure the I/O for an example system.
The H4–EBC is connected to the PC which
is running Think & Do software.

To start a new configuration, select the
Configuration menu, then New as
shown.

Starting I/O View

Starting a New
Screen in I/O View
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The next screen is divided into three regions separated by window splitter bars. You
can re-size the regions by doing a click-and-drag on a splitter bar.

Each project maintains its own record of
its I/O configuration.

The first time you open the I/O View win-
dow for a new project, it will prompt you
to choose an I/O driver, as shown below.

Use the Drivers menu and select Add, as
shown, to access a list of I/O drivers.

Select the PLCDirect Ethernet I/O
driver. Click OK.

Selecting a Driver
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I/O View adds the driver, and attempts to
activate the network adapter card. I/O
view displays an image of the card as
shown to the right.

Select the Configuration pull-down
menu from the I/O View menu bar as
shown to the right. Then select Connect
from the menu. This instructs Think & Do
to make the connection to the I/O bases
currently on the network.
The module must have a non-zero
Module ID set on the DIP switch or an
error message will be returned at this
point. See page 2–4 “Setting the DIP
Switch” for more information.

Think & Do makes a connection to the H4–EBC and automatically displays the
H4–EBC Base Configuration screen. The screen will overlay the I/O View screen.
Discrete and analog modules are both displayed initially as a dashed horizontal line
“-–––––” in the block representing the module’s slot location.

If you have digital inputs and outputs but no analog inputs or outputs, you do not
need to do anything additional to configure the base. You may click on Exit or Update
Base. Either will return you to the I/O View screen.

Note: High Speed Counter module may be indicated
as D4–HSC or H4–HSC. They are the same.

H4–EBC Base
Configuration
Screen
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You must identify each analog input or output module by selecting the applicable part
number on the Base Configuration screen. The part numbers of all available analog
modules appear on the pull–down menu for the appropriate slot (the part number is
printed on the face of each module). Click on the arrow beside the slot location to see
the menu. The H4–EBC automatically distinguishes between input modules and
output modules. In the Think & Do implementation of the Base Configuration utility,
the pull-down menu for analog input modules lists only analog input modules. It does
not list analog output modules.

The pull-down menu for analog output modules lists only analog output modules.

After selecting the appropriate part number for your analog input or output modules,
click on Update. This will save the entries to the H4–EBC’s non-volatile memory.

After clicking on Update, a graphical representation of the H4–EBC, the base, and
I/O modules appears. You have successfully configured the I/O base. The I/O View
screen shows an eight-slot base even if you are using a smaller base. Expansion
bases are also shown if connected.

Identifying
Analog Modules
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Using H2–EBC with KEPware OPC Server

Introduction to KEPServerEX
OPC, OLE (Object Linking and Embedding) for Process Control, is an industry
standard created by a number of worldwide leading hardware and software
suppliers in cooperation with Microsoft. The OPC Data Access specification, as
maintained by the OPC Foundation, is a non–proprietary technical specification that
defines a set of standard interfaces based upon Microsoft’s OLE/COM technology.
An OPC server (driver) allows items such as distributed control systems,
programmable logic controllers, I/O systems and smart field devices to
communicate with a wide range of HMI/SCADA (client) software packages residing
on a PC. Traditionally, each software or application developer was required to write a
custom interface, or server/driver, to exchange information with hardware field
devices. OPC eliminates this requirement allowing manufacturing customers true
plug and play connectivity and the freedom to choose products based on their
automation requirements.

While KEPServerEX is first and foremost an OPC server, KEPware recognized that
a number of legacy applications still depend upon DDE for their underlying client
server technology. Early in the development of Windows, Microsoft provided a
generic client server technology called DDE (Dynamic Data Exchange). DDE did
provide a basic architecture that would allow many windows applications from a
wide range of vendors to share data. But there was one problem, DDE was not
designed for the industrial market lacking much of the speed and robustness desired
in an industrial setting. However, this did not stop DDE from becoming a dominant
client/server architecture, largely due to its availability in most windows applications.

KEPServerEX Enhanced OPC/DDE Server is a 32 bit windows application that
provides a means of bringing data and information from a wide range of industrial
devices and systems into client applications on your Windows PC. KEPServerEX
falls under the category of a ”Server” application. It is very common to hear the term
”client/server application” in use across many software disciplines and business
segments. In the industrial market, it has usually come to mean the sharing of
manufacturing or production data between a variety of applications ranging from
human machine interface software and data historians, to large MES and ERP
applications.

 At a high level, the KEPServerEX OPC Server is comprised of several objects that
are described on the next page.

Channel Object

Device Object

Group Object

Tag Object

Introduction
to OPC

DDE Support

KEPServerEX
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Using H2–EBC with KEPware OPC Server

Channel Object: Each protocol or driver used in a KEPServerEX project is referred
to as a channel. A channel refers to a specific communications driver. A
KEPServerEX project can consist of many channels each with unique
communications drivers or each with the same communications driver.
Each channel name must be unique in a KEPServerEX application. The channel
name entered here will be part of the OPC browser information.

Device Object: Unlike the channel name, ”Device names” can be the same from
one channel to the next. The device name is a user defined logical name for the
device. The device name and channel name will be part of the OPC browser
information as well as a DDE item name. Within an OPC client the combination of
channel name and device name would appear ”ChannelName.DeviceName”.

Group Object: KEPServerEX allows tag groups to be added to your project.  Tag
groups allow you to tailor the layout of OPC data in logical groupings that fit the
needs of your application. Using tag groups allows multiple sets of identical tags to
be added under the same device. This can be very convenient when a single device
handles a number of similar machine segments. From an OPC client standpoint, the
use of tag grouping allows you to segregate your OPC data into smaller tag lists,
which can make finding a specific tag easier when browsing the server.

Tag Object: KEPServerEX allows both dynamic tags, (tag entered directly at the
OPC client that specify device data) and user defined tags. User defined tags have
the benefit of allowing the tag to be browsed from an OPC client that supports tag
browsing. User defined tags also support tag scaling. Unlike many of the dialogs you
will find in KEPServerEX, the tag properties dialog has a number of features that are
driven by icons. The tag name is part of the OPC browse data. Tag names must be
unique within a given device branch or tag group branch. If your application is best
suited by using blocks of tags with the same names, use tag groups to segregate the
tags.
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Using H2–EBC with KEPware OPC Server

KEPServerEX Project: Adding and Configuring a Channel

KEPServerEX, like any OPC server, can be started a number of ways. One of the
benefits of OPC technology is that your OPC client can automatically invoke the
server when it attempts to connect and collect data from it. In order for this automatic
mode of operation to occur you must first create and configure a project. Once you
have created a project, KEPServerEX will automatically select the most recently
used project when it is invoked by an OPC client.
Initially however, you need to manually invoke KEPServerEX using either the
desktop icon, if you chose to install it, or by selecting KEPServerEX from the
windows start menu.  Depending on any changes you may have made to the
appearance of KEPServerEX, once invoked you should be presented with the
following interface.  To learn more about the various elements of the user interface
see (Basic KEPServerEX Components).
While discussing how to start KEPServerEX its important to understand what the
system requirements are for running the server.  KEPServerEX has been designed
to place as little strain on your system as possible.
Recommended System Requirements:
   400Mhz Pentium
   64 Megs of Ram
   10 Megs of Hard Disk Space
   Windows NT(SP6a)/2000 (Strongly recommended for industrial settings)
   Available Ethernet Card

A channel refers to a specific communications driver. A KEPServerEX project can
consist of many channels each with unique communications drivers or each with the
same communications driver. Depending on the driver or drivers you have installed
you can define a number of channels within a single project. A channel acts as the
basic building block of an OPC link. Properties like communications port, baud rate,
and parity are contained at the channel level. Each channel name must be unique in
a KEPServerEX project. The channel name can be up to 31 characters long. 
To add a new channel to your project you can use the Edit menu > New Channel, the
Toolbar Add Channel, or the “Click to add a channel” dialog.

Running the Server

Adding a Channel



A
ppendix D

H
2–E

B
C

/K
E

P
w

are O
P

C
D–5

Using H2–EBC with KEPware OPC Server

Select the device driver you want to assign to the channel. A driver list will be
presented displaying all of the device drivers that are installed in your system.

Selecting the ”Enable diagnostics” check box will enable diagnostic information to
be available to your OPC application for this channel. With diagnostic functions
enabled, diagnostic tags are available for use within client applications.  In addition
to diagnostic tags, a diagnostic window is also available when this feature is
enabled. The diagnostic features of KEPServerEX do require a minimal amount of
overhead processing. For this reason it is recommended that you only use the
diagnostic features when needed and disable them when not in use which is the
default case.

The Network Interface selection allows you to select a specific NIC card for the
Automationdirect EBC Ethernet driver to use based on the NIC name or its assigned
IP address. By selecting a specific NIC interface you will be able to force the driver to
send all Ethernet communication through the specified NIC. If you do not know
which NIC you should use, select the ”Default” condition.

Selecting the 
Device Driver

Selecting the 
Network Adapter
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As with any OPC server, writing data to your device may be the most important
aspect of your application. Insuring that the data written from your OPC client
application gets to the device in a timely manners is the goal of the server.
KEPServerEX provides a number of optimization settings that can be used to tailor
the server to meet the needs, and improve the responsiveness of your application.

There are currently three write optimization modes. The following is a brief
description of the modes. For a detailed explanation, refer to the “Channel
Properties – Write Optimizations” section in the KEPServerEX on–line help file.

NOTE: We strongly suggest that you characterize your application for
compatibility with these write optimization enhancements before using them
in a production environment.

The default mode, ”Write all values for all tags” will force the server to attempt to
write every value to the controller. This mode insures that everything written from
your OPC client applications will be sent to the target device. While writing every
value to the device may seem like the best course of action, there are a number of
applications where writing every value, many of which may be the same value, over
and over may be simply a waste of communications bandwidth.
The ”Write only latest value for non–boolean tags” allows any value that is not a
boolean value to be updated in the server’s internal write queue and will then be sent
to the device at the next possible opportunity. This can dramatically improve the
overall performance of your application. This feature must be used with a clear
understanding of how it will affect the operation of your application.
The final write optimization mode, ”Write only the latest value for all tags”, takes
the operation described for the second mode and applies it to all tags.

The Duty Cycle selection allows you to control the ratio of write operations to read
operations. By default the duty cycle is set to ten. This means that ten writes will
occur for each read operation. If your application is doing a large number of
continuous writes but you need to insure that read data is still given time to process,
you may want to reduce the Duty Cycle. A setting of one will result in one read
operation for every write operation. In all cases if there are no write operations to
perform, reads will be processed continuously.

Setting the 
Server Writes
Optimizations
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Using H2–EBC with KEPware OPC Server

With Channel1 added to the server, the KEPServerEX window will appear as
follows:

Note that the channel is shown using the channel name given, but it also has a small
red ”x” below the channel icon. The red ”x” indicates that the channel does not
contain a valid configuration. Channel1 is not valid because a device has not yet
been added to the channel.

KEPServerEX supports the use of multiple channels. As you add channels to your
project you can specify either the same communications driver or different
communications drivers. Most communication drivers offered by KEPware support
operation on up to 16 communications ports or ethernet network connections
simultaneously. By defining multiple channels you can improve the overall
performance of you application. In the case of either a serial driver or Ethernet driver
using multiple channels allows you to spread large communications loads across
the multiple channels. A good example of this would be a serial driver that is being
used to communicate with eight devices on the serial line. Normally the
communications driver used in this application would be responsible for gathering
data from all eight devices in a round robin fashion. If this same application is
reconfigured to use multiple channels assigned to multiple communications ports,
the device load can be divided across the channels. The end result is reduce work
load on each channel and dramatic improvements in the responsiveness of your
application. The need to use multiple channels is dependent solely on the needs of
your application. In either case there is no additional cost involved to use a licensed
driver on multiple communications or Ethernet ports.

Saving the New
Channel Settings

Using Multiple
Channels in a
Project
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Using H2–EBC with KEPware OPC Server

KEPServerEX Project: Adding and Configuring a Device

Once a channel has been configured in a KEPServerEX project, a device must be
added to the channel. Devices represent PLCs, I/O devices or other hardware that
the server will communicate with. Device selection is restricted by the device driver
the channel is using.
To add a device to a channel, select the desired channel and use the Edit menu >
New Device, the Toolbar Add Device, or the “Click to add a device” dialog.

The ”Model” parameter allows you to select the specific type of the device
associated with a device ID. The contents of the model selection drop down will vary
depending on the chosen communication driver.

Adding a Device

Selecting the
Device Model
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Using H2–EBC with KEPware OPC Server

The ”Device ID” parameter allows you to specify the driver specific station or node
address for a given device. Since the Automationdirect EBC driver is an Ethernet
based driver, a unique and valid TCP/IP address must be entered. IPX protocol is not
supported.

Device timeout parameters allow a driver’s response to error conditions to be
tailored to the needs of your application. The timeout parameters are specific to each
device you configure. Each of the field parameters is defined in detail in the “Device
Properties – Timeout” section in the KEPServerEX on–line help file.

The Connection timeout: allows the time required to establish a socket connection
to a remote device to be adjusted. The Request timeout: is used by all drivers to
determine how long the driver will wait for a response from the target device. The
Fail after parameter is used to determine how many times the driver will retry a
communications request before considering the request to have failed. If your
environment is prone to noise induced communications failures you may want to
increase the number of retries the driver performs.

Selecting the
Device Model

Setting the Device
Timeout Properties
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Using H2–EBC with KEPware OPC Server

The automatic OPC tag database generation features of KEPServerEX have been
designed to make the setup of your OPC application a Plug and Play operation.
Since the Automationdirect EBC communication driver supports this feature, you
can configure it automatically build a list of OPC tags within KEPServerEX that
correspond to device specific data. The automatically generated OPC tags are then
browsable from your OPC client. The OPC tags that are generated are dependent
upon the nature of the supporting driver. Each field selection is defined in detail in the
“Automated OPC Tag Base Generation” section in the KEPServerEX on–line help
file.

The ”Automatic tag database generation on device startup” selection allows you
to configure when OPC tags will be automatically generated. There are three
possible selections. The default condition, ”Do not generate on startup”, will
prevent the driver from adding any OPC tags to tag space of KEPServerEX. The
selection ”Always generate on startup”, will cause the driver to always evaluate
the device for tag information and to add OPC tags to the tag space of the server
each time the server is launched. The final selection ”Generate on first startup” will
cause the driver to evaluate the target device for tag information the first time this
KEPServerEX project is run and to add any OPC tags to the server tag space as
needed. When the automatic generation of OPC tags is selected, any tags that are
added to the server’s tag space must be saved with the project. You can configure
your KEPServerEX project to auto save from the Tools > Options menu.

With Device1 added to Channel1, the KEPServerEX window will appear as follows:

Automatic OPC 
Tag Database
Generation

Saving the New
Device Settings
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Using H2–EBC with KEPware OPC Server

KEPServerEX Project: Adding Tags to the Project

There are two ways to get data from a device to your client application using
KEPServerEX. The first method, and most common method, of defining tags is
called User Defined Tags. This requires that you define a set of tags in the server
project and then use the name you assigned to each tag as the item of each
OPC/DDE link between the client and the server. The primary benefit to this method
is that all user defined tags are available for browsing within OPC clients.
Additionally, user defined tags also support scaling.
The second method of defining tags is called Dynamic Tags. Dynamic tags allow
you to define tags in the client application. Instead of providing the server with a tag
name as the OPC/DDE item, you would provide the device address (and optionally a
data type). The server will create a tag for that location and start scanning for data
automatically. KEPServerEX allows tag groups to be added to your project. 
Tag groups allow you to tailor the layout of OPC data in logical groupings that will fit
the needs of your application. Using tag groups allows multiple sets of identical tags
to be added under the same device. This can be very convenient when a single
device handles a number of similar machine segments. From an OPC client
standpoint, the use of tag grouping allows you to segregate your OPC data into
smaller tag lists, which can make finding a specific tag easier when browsing the
server.

Each field selection is defined in detail in the Tag Properties section in the
KEPServerEX on–line help file. A brief description of each is listed below.

The tag Name: parameter allows you to enter the string that will represent the data
available from this tag. The tag name can be up to 31 characters in length. While
using long descriptive names is generally a good idea, keep in mind that some OPC
client applications may have a limited display window when browsing the tag space
of an OPC server. The tag name is part of the OPC browse data. Tag names must be
unique within a given device branch or a tag group branch. If your application is best
suited by using blocks of tags with the same names, use tag groups to segregate the
tags.

User Defined Tags
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Using H2–EBC with KEPware OPC Server

The Address: parameter allows you to enter the desired driver address for this tag.
To determine how an address should be entered, you can use the Hints button next
to the address parameter. Hints provide a quick reference guide to the address
format of the driver. Once you have entered an address you can test it by using the
check address button. When pressed, the check address button attempts to validate
the address with the driver. If the driver accepts the address as entered no message
will be displayed. If an error is detected a pop–up will inform you of the error. Keep in
mind that some errors will be related to the data type selection and not the address
string.

The Description: parameter allows you to attach a comment to this tag. A string of
up to 64 characters can be entered for the description. If you are using an OPC client
that supports Data Access 2.0 Tag Properties, the description parameter will be
accessible from the Item Description property of the tag.

The Data Type: selection allows you to specify the format of the tag’s data as it is
found in the physical device. The data type setting is an important part of how a
communication driver reads and writes data to a device. For many drivers the data
type of a particular piece of data is rigidly fixed. 
The available data type selections are:

� Default – This type allows the driver to choose its default data type see the
specific driver help for details

� Boolean – Single bit data On or Off

� Char – Signed 8 bit data

� Byte – Unsigned 8 bit data

� Short – Signed 16 bit data

� Word – Unsigned 16 bit data

� Long – Signed 32 bit data

� Dword – Unsigned 32 bit data

� Float – 32 bit Real value IEEE format

� String – Null terminated ASCII string

� Double – 64 bit Real value IEEE format

� BCD – Two byte packed BCD value range is 0 – 9999

� LBCD – Four byte packed BCD value range is 0 – 99999999

The Client access: selection allows you to specify whether this tag is Read Only or
Read/Write. By selecting Read Only you can prevent client applications from
changing the data contained in this tag. By selecting Read/Write you are allowing
client applications to change this tag’s value as needed. 

The DDE scan rate: parameter allows you to specify the the update interval for this
tag when used in a DDE client.  OPC clients can control the rate at which data is
scanned by using the update rate that is part of all OPC groups.

The Do not allow client to override data type selection allows you force OPC
clients to use the data type you have specified for this tag. OPC clients can specify
how they desire to view the data from a particular tag.
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To determine how an address should be entered, use the Hints button “?” to the right
of the address field. Hints provide a quick reference guide to the address format of
the driver.

 Once you have entered an address you can test it using the check address “�”
button. When pressed, the check address button attempts to validate the address
with the driver. If the driver accepts the address as entered, no message will be
displayed. If an error is detected, a pop–up window will inform you of the error. Keep
in mind that some errors will be related to the data type selection and not the address
string. Below is an example of a valid tag properties.

The window below shows a valid configured channel, device and several user
defined tags.

Creating a 
User Define Tag
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Using H2–EBC with KEPware OPC Server

H2–EBC I/O Addressing

I/O slots must be individually addressed in the following form: S<ss>:<t><nn> where
ss is the slot number (0 to 8), t is the address type (X, Y, K, V, DI, D0, WI, W0, etc.),
and nn is the address. The address ranges from 0 to an upper limit determined by the
module occupying the slot.

       I/O Type             Syntax            Data Type

Discrete Inputs X or DI<nn>
nn = Bit Number (decimal)

Boolean, Byte, Char,
Word, Short, DWord, Long

Discrete Outputs Y  or DO<nn>
nn = Bit Number (decimal)

Boolean, Byte, Char,
Word, Short, DWord, Long

Byte Inputs BI<nn>
nn = Bit Number (decimal)

Byte, Char

Byte Outputs BO<nn>
nn = Bit Number (decimal)

Byte, Char

Word Inputs K  or WI<nn>
nn = Bit Number (decimal)

Word, Short

Word Outputs V  or WO<nn>
nn = Bit Number (decimal)

Word, Short

DWord Inputs DWI<nn>
nn = Bit Number (decimal)

DWord, Long

DWord Outputs DWO<nn>
nn = Bit Number (decimal)

DWord, Long

Float Inputs FI<nn>
nn = Bit Number (decimal)

Float

Float Outputs FO<nn>
nn = Bit Number (decimal)

Float

Double Inputs DBI<nn>
nn = Bit Number (decimal)

Float

Double Outputs DBO<nn>
nn = Bit Number (decimal)

Float

Each field selection is defined in detail in the “Tag Properties” section in the
KEPServerEX on–line help file.

H2–EBC
Module

Slot 0
8 Inputs

Addresses
S0:X0

to
S0:X7

Slot 1
32 Inputs

Addresses
S1:X0

to
S1:X31

Slot 2
4 Analog Inputs

Addresses
S2:K0

to
S2:K3

Slot 3
8 Outputs

Addresses
S3:Y0

to
S3:Y7

Slot 4
16 Outputs

Addresses
S4:Y0

to
S4:YI5

Slot 5
8 Analog Outputs

Addresses
S5:V0

to
S5:V7

H2–EBC I/O
Addressing
Example
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Using the KEPware OPC Quick Client

Creating a KEPServerEX Quick Client Project
KEPServerEX Quick Client can be used to assist in the test and development of
KEPware’s OPC Data Access 1.0 and 2.0 Servers.

A server connection provides a link between the Quick Client and the KEPServerEX
OPC server. To add a server connection to the Quick Client, you can use either the
Edit menu>New Server Connection or click on the New Server icon in the toolbar
menu.

Specify the Prog ID of the OPC Server the client should connect to. You can browse
for registered servers by expanding any of the branches. Double–clicking on any
registered server will automatically update the Prog ID field. For more information on
the registered servers, click on the Help button to display the “Server Connection”
section of the on–line help file. Once a connection to the OPC server has been
established, additional “Server Operations” can be accessed by right clicking on the
highlighted server in the right window column or by using the Tools menu>Server
selection.

A group is used to organize a collection of items with a common set of properties. To
add a Group to the Quick Client, you can use the Edit menu>New Group or click on
the New Group button in the toolbar menu.

A The group specifies the following properties: group Name, Update Rate, Time
Bias, Percent Deadband, Language ID, Active State and the typeof data
connection that should be made to the server. For detailed information on the group
properties, click on the Help button to display the “Group” section of the on–line help
file. Once a Group has been created, additional “Group Operations” can be
accessed by right clicking on the highlighted branch Group or by using the Tools
menu>Group selection.

Connecting the
Client to the 
OPC Server

Creating a Client
Group
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Using the KEPware OPC Quick Client

Items represent data that may be accessed via the OPC server. An item specifies
the following properties: Access Path, Item ID, Data Type and Active state. For
detailed information these properties, click on the Help button to display the Item
section of the on–line help file. To add an Item to the Quick Client Group, you can
either use the Edit menu>New Item or click on the New Item icon on the toolbar.

1 2

3

4

If the OPC Server was configured to automatically generate OPC tags, the
generated tags would be browsable from the OPC client. If automatic tag generation
was not selected, create an item by:
    1) browsing the OPC Server branch tags
    2) highlighting the desired tag in the right column
    3) clicking on the “Add Leaves” button
    4) clicking on the “Green Check Mark” button to validate the item
    5) and clicking on the “OK” button. 

After clicking on the OK button, the following window will display the created items.

Selecting a 
Group Item
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Using the KEPware OPC Quick Client

Item operations can be accessed by right clicking on the desired item or by using the
Tools menu>Group selection.

After clicking on the desired item operation, a window similar to the following will be
displayed. In this example, a logic 1 value (Boolean data type) is being written to a
discrete output to turn it on. The item operations can be used to read discrete/analog
inputs and write to discrete/analog outputs, etc.

Item Operations
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Using the KEPware OPC Quick Client

Using the RJ12 Serial Port in ASCII Mode

The H24–EBC RJ12 serial port can be configured for generic ASCII
communications (refer to the “Advanced Settings” section in Chapter 3 to confirm or
change the RJ12 serial port settings). Both the transmit buffer and receive buffer of
the driver are 127 bytes in size. Thus, the corresponding tags can be a maximum of
127 bytes. Incoming bytes are appended to the receive buffer. 
Port specifiers precede the serial port address. It defines which port the serial port
address corresponds to. To define an EBC address the mnemonic EBC is used and
the mnemonic SP0 specifies serial port 0. For addressing the EBC serial port, no
base or slot information is needed.
As shown below in the Hints dialog, there are several port address parameters. In
many cases the default values can be used. A detailed list explaining the parameters
are found by clicking on the Help button in the Hints window. Then click on the Index
button in the Terminator I/O, I/O Addressing window. Then locate the “H2, H4,
Terminator I/O Serial Port Addressing” help section.

�

The communication parameter defaults are:
� 9600 baud
� 8 data bits (7 may be selected)
� no parity (odd or even may be selected)
� 1 stop bits (2 may be selected)
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Using the KEPware OPC Quick Client

The following tags were created in the KEPServerEX OPC server for this example.
� EBC:SP0:MODE
� EBC:SP0:DATAIN

The tags created above were browsed and selected as items within the Quick Client
as shown below. The EBC.SP0.MODE address must be set to a value of 1 to select
the ASCII communications mode. The ASCII string ASCII String Input Test
Successful was entered via the RJ12 serial port. The ASCII Sting displays in the
ASCII_Data_Input Item ID’s Value column.




